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Introduction 

 
Forest fire is a natural event that occurs periodically across forests in the Western United States. 

Even though fire is a natural event, the scale, frequency, and severity of such fires can be 

devastating to endangered communities of plants and animals as the size, composition, age and 

health of the forests in the Western United States has evolved over the last 200 years. The 

impacts of large fires today are enhanced by the fact that development and past harvesting has 

created a fragmented landscape, reducing the sizes of refugia for endangered and threatened 

species. Protecting native species such as the California spotted owl and old-growth mixed 

conifer stands will be successful, in part, based upon landscape planning and fire management 

techniques. The ultimate goal would be to move towards management that involves fire in all of 

its variability. Attaining that goal rests on making forested areas more resilient to fire than they 

are at present.  

Making a landscape more resilient to fire is based upon strategic plans of reducing landscape 

fuels, so that the possible severity of fire is reduced for a given fire scenario. Even though 

historic fires have been shown to be very large and severe, forested landscapes were more 

resilient due to their historic size and range. Without attempting to treat the forests to make them 

more resilient, fires of today may well threaten species of concern. Consequently, the USFS has 

taken concerted steps towards modeling fire and developing fuel management plans in order to 

protect not only old growth stands, but other elements including the Wildland Urban Interface 

(WUI). Based upon the work of Mark Finney and his colleagues, it is now believed that 

strategically placed areas of treatment for fuel removal can help reduce the size and severity of 

naturally occurring fires. The idea is that placing fuels treatment areas across the landscape will 

make a forest more resilient, so that a fire will be a healthy event rather than a devastating event. 

The resources to accomplish a fuels treatment plan on a Ranger District or at the National Forest 

level are far too great to accomplish in a few years. Thus, it is necessary to select a set of 

treatment areas (called SPLATS) across a forest and schedule them over a time horizon. This last 

element, the process of scheduling, is the objective of the mFASST program (the Forest activities 

scheduling system tool for maintenance and initial fuels treatments). 

The mFASST program was developed as an outgrowth of an earlier program called iFASST. 

When fuels removal planning was initiated, forest planning staffs were faced with the task of 

scheduling initial fuels treatment activities over a long planning horizon. These initial treatment 

activities were comprised of such approaches as thinning, mechanical removal of downed litter 

and ladder fuels, as well as controlled burns. The area around these fuel treatments have been 

shown to benefit from the removal strategies through the use of fire simulation models based 

upon the impact on fuels inventories after treatment has been applied. The typical planning 

process has involved considerable interaction between forest experts, planners, fire analysts, 
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biologists, and project specialists. Once SPLATS have been defined on a forest, analysts then 

model fire based upon a number of scenarios. Often, the SPLAT locations and treatment 

strategies are then refined to help address specific issues raised in the fire simulation runs. The 

objectives of the treatments are multifaceted, in that there is an attempt to reduce the probability 

that old-growth will be subjected to devastating fire events, a need to protect WUI areas, and 

make large tracts more resilient to devastating fire by clustering treatment activities across the 

forest over time. Given that resources are limited, many of these planned treatment activities 

must be scheduled over a relatively long horizon (e.g. 20-30 years).  This is a scheduling 

problem that can take considerable time and effort to develop without the aid of specialized 

scheduling programs, like mFASST. The output of mFASST can be tracked by planners using 

software like Microsoft Project, tracked in GIS software such as ARC/MAP from ESRI, and can 

be analyzed in a number of different ways within the mFASST program as well. 

The mFASST program not only schedules treatment activities according to specified objectives 

and objective weights, it produces charts which can be used to track the impact of activities on 

treated WUI acres, disturbed acres of sensitive habitat, track acres that meet Finney conditions 

over time, as well as other metrics. It is also possible to tradeoff different objective performance 

values by running the mFASST scheduler for different sets of object weights, and for different 

constraint values (e.g. yearly budgets).  

What makes the mFASST program different from the earlier program called iFASST is that 

mFASST schedules both initial treatment activities as well as maintenance activities. If an area 

has been treated under an initial fuels treatment strategy, then the vegetation will evolve over 

time, producing litter and other fuels that will accumulate over time. This accumulation, if not 

treated at some future time will return the forest to a condition similar to that which existed 

before the initial treatment. Consequently to keep an area in a perpetual state of “Finney,” 

follow-up maintenance is required periodically until a long range plan transcends into an 

equilibrium state with fire. Such treatment, initial or maintenance, will not prevent forest fire, but 

it is hoped that it will aid in reducing the severity and size of a fire during a specified time 

horizon (e.g. a 5 day dry weather event with 30 mph winds). The goal is that over time, the forest 

will be at equilibrium and fire events neither threaten sensitive habitats to a major extent, nor 

cause major issues when left to burn without suppression activities.       

The problem of scheduling fuels treatment activities over time is quite complex. It can be done 

by hand, but there are so many activities to schedule and metrics to track that the task can be 

overwhelming in size, and will likely lead to a sub-optimal result. Further, the task could take a 

considerable amount of time to perform. The mFASST program is designed to make the task 

quick and easy, giving the analyst the ability to generate many different possibilities, based upon 

different object weights and scenarios. In short, this tool has been designed so that analysts can 

spend their efforts at generating and analyzing many plans in a reasonable amount of time, rather 

than struggling with the development of one plan without the chance to analyze other scenarios 

and plans. Thus, it is an aid in making their role more comprehensive and efficient.  
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The first version of mFASST was written with a map interface that employed ARC objects. This 

stand-alone program required an ESRI License in order to run. Several versions of this were 

released as ESRI changed features and license file protocols. When ESRI released version 10 of 

ARC/MAP, changes in mFASST were required to keep it compatible, including the availability 

of an ESRI ARC/server license. Because of the license requirements and the requirement that the 

program would need to be completely restructured in the .NET environment, effort was directed 

towards identifying the alternatives to using ARC objects to support map functionality in the 

mFASST interface. The major problem is that ESRI’s development pathway placed specific 

restrictions on the computational efficiency of any future program, computational constraints that 

were considered onerous and coding requirements that were considered to be counterproductive. 

Consequently, over the last six months the GIS environment of mFASST was stripped of ARC 

objectives and rewritten to use open source GIS functionality based upon MapWindow GIS
1
. 

This new version is called mFASST version 2.0. This new version does not need an ESRI 

license, and will run in an MS Windows environment royalty and license free. This version does 

not contain any references to ESRI products, and can be distributed to any USFS office and its 

installation is aided by an installation package.  

Like all software that is developed, there are bugs that have not been identified in testing. If 

during the application of this program any conditions are encountered that indicate an issue that 

is unintended, it is important for a report of the issue be directed to the authors of this manual. In 

the next section we describe some major elements of the program from a high level perspective. 

The details of using the program are described in subsequent sections of this report. 

High-level perspective on the scheduling problem of mFASST  
 

The mFASST scheduling problem involves scheduling fuels treatments across a forest according 

to a set of specified objectives and constraints. Fuels treatments can be initial treatments or 

maintenance treatments. Each treatment is defined in the terms of a small spatial unit that is 

comprised of one or more SPLATS (spatially placed landscape area treatments). All SPLATS of 

a treatment unit are scheduled as a unit. A treatment unit is referred to as an SUNIT (Spatial 

Unit). Figure 1 illustrates this. If all SPLATS are treated within a SUNIT on the appropriately 

defined timeline, then the Finney condition will be maintained. That is, the condition in which 

fire spread across the unit and the severity of the fire in the unit will be similar to what would 

occur if all of the area in the SUNIT is treated (and not just the area within the SPLATS). The 

major objective in fuels treatments is to reach and maintain the “Finney” condition in as much of 

the forest as quickly as possible and maintain this condition to the highest extent possible while 

working within a constraint on budget and within a constraint on the amount of sensitive habitat 

that can be disrupted in any given year.    

                                                 
1
 See www.mapwindow.org for more information on the MapWindow GIS. 
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Figure 1 – Example of SUNIT containing SPLATS 

 

The SPLATS within a treatment unit, or SUNIT, are composed of either initial treatment, 

maintenance treatment or a combination of both. The data to support treatment scheduling is 

defined for each SUNIT. Specifically, for each SUNIT, a combined total of activities is specified 

in terms of net revenue (or cost) that represents what is needed to be accomplished in treating all 

SPLATS needing initial treatment, as well as a combined total of the activities needed to 

accomplish treating all SPLATS needing maintenance. It is entirely possible that an SUNIT 

contains only “maintenance” SPLATS or “initial” SPLATS. The real issue is that each SUNIT is 

characterized appropriately. Each total, whether, initial or maintenance, is defined with timing 

elements. Such timing elements define when the treatment can be done at its earliest date, the 

time spread in which it will take to complete (1 year, 2 years,…., etc.) and the date at which its 

“Finney” effect will be lost without a subsequent follow-up maintenance treatment. Scheduling 
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is accomplished to maximize acres meeting the “Finney” condition in each year in combination 

with the other objectives (each is weighted to their overall level of significance)
2
. 

An area, or SUNIT, is defined to meet the “Finney” condition when all initial treatments are 

accomplished. If initial treatments are not followed up by maintenance treatments within a 

prescribed time window, the SUNIT will lapse out of the “Finney” condition. The program 

attempts to schedule activities so that there is a connected large region of the forest that meets 

the Finney condition over a planning horizon, subject to budget constraints. It tracks the 

clustering of treatment units by the use of adjacency information that is generated from the shape 

file representing the region being scheduled. Treatments can be prioritized so that WUI acres and 

sensitive habitat areas are protected as soon as possible by the Finney condition.   

The scheduling problem that is addressed by the mFASST program is defined mathematically in 

a companion paper on fuels treatment scheduling. This model is a large-scale integer-linear 

programming problem. The iFAAST model (a sub model of mFASST) has been solved to 

optimality for small data sets, but has been found to be extremely difficult if not impossible to 

solve to optimality for an entire ranger district or National Forest comprised of hundreds of 

spatial units (SUNITs) and a time horizon of 20 years of more. The problem is that the iFASST 

model applied to a national forest is comprised of hundreds of thousands of continuous variables 

and constraints, as well as thousands of integer scheduling variables. What makes this especially 

hard to solve to confirmed optimality is that there exist many relatively close to optimal solutions 

and the resulting branch and bound tree is both broad and deep. Because of this fact, and the 

issue that the model can take weeks if not months to solve using the best commercial software, 

the iFASST and mFASST programs have been designed around a heuristic search strategy. 

Specifically, both iFASST and mFASST use a GRASP approach that employs “Path Relinking” 

and an elite pool of solutions. This sophisticated solution approach is state of the art and is 

described in the companion paper as well.  

The main objective of this document is to describe how the mFASST program can be used. It is 

assumed that the user is an expert at analysis and has used similar programs. It is also assumed 

that the user has an understanding of and a familiarity with the data necessary to apply this 

program. The key to its use is a set of data files that contain specific elements of the problem. 

This set is depicted in Figure 2. The key integrative file is called the BaseFile. This file can be 

either generated using a file editor (e.g. notepad, or notepad++) or can be generated by the 

BaseFile creator functions in mFASST. The BaseFile links all of the files together and specifies 

which data fields are used in the model. It also specifies which objectives are to be used and 

which data fields are used to define them. The details file holds the two major parameters of the 

                                                 
2
 When one selects weights for each objective, it is important to set each weight at a value that is greater or equal to 

zero. It is also important to recognize that a given weight should be based upon the relative importance of the 

individual objective and the relative difference in each achievable objective function term. Thus, wise use dictates 

testing different values of objective weights to ensure that the final solution represents the appropriate tradeoff 

between objective values.    
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problem: the number of planning periods and the number of spatial units. In Figure 2, the basics 

of each file are specified. In order to execute the mFASST program all files in Figure 2 must 

have been created in advance, except for the base file. When running the program for a given 

forest or ranger district for the first time, it is necessary to have a basefile or to generate one 

using mFASST before proceeding to the task of scheduling.    

 

Figure 2 - The basic set of files needed to develop a schedule. All files must have been 

created before using mFASST with the exception of the BaseFile 

There are several other files that are used by the mFASST program, but their initialization is not 

required by the user. They are the Adjacency file, the Color Scheme file and the Fixed Schedule 

file. These file types are depicted in Figure 3. Each of these files is either generated 

automatically when needed or can be enhanced by the user. For example, the Color Scheme file 

contains color schemes to be used in depicting the treatment schedules on a map. The colors and 

their shades change by year. A color scheme file is provided with a release copy of the program, 

but new schemes can be defined and saved in mFASST and/or selected from an archived set of 

schemes. The Adjacency file is generated by mFASST once for a given problem shapefile and 

saved. It is then retrieved for any subsequent use involving that data set as it takes extra time to 

generate this file.   

The data setup is the most important step in using the mFASST program. It is necessary to 

characterize all elements of the problem before running the scheduling model. To help in that 

process, a data set for Sequoia National Forest is provided with the release copy of the program. 
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The data files are stored in different folders all under the general file folder called Data. Using 

notepad, it is possible to inspect many of these files, except the proprietary GIS shape files. 

 

Figure 3 - Files provided or generated through the use of the mFASST program 
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Installation 

 

How to Install the mFASST Program 
 

To install mFASST, follow the steps described below: 

 

 Step 1: To successfully install the program download and unzip the installation 

executable to a folder; the folder name can be whatever you choose. A total of three files 

should be present in the folder you create: setup.exe, SETUP.LST, and an mFASST 

CAB file named something like mFASST_(2.0)_08-18-2011_Beta.CAB.  

 

 Step 2: Double click on the setup.exe executable and follow the installation prompts until 

the program has been installed. If you get any version conflict messages (See Figure 4) 

click yes so that you keep the latest version of Active X components from Microsoft. 

This will sometimes occur when installing on a fresh install of Windows 7 that has not 

been updated. 

 

 Step 3: Click the Windows (Start) Button, then the All Programs button, and then locate 

the mFASST folder, expanding it.  

 

 Step 4: Click on the Install Dependent Data Folders program link. Follow the installation 

prompts until the program has completed installation.  

 

 Step 5: Navigate to the mFASST folder in the All Programs menu, as previously 

described in Step 3, and click the Install MapWindow COM Module program link. Follow 

the prompts to install this program. Once completed, you are ready to launch the 

mFASST executable from the All Programs menu. 

 

Using the Executable Outside of the “My Programs” Directory  
 

If you wish to use the mFASST executable outside of the “My Programs” menu, the executable 

may be copied and pasted outside of the “My Programs” directory so long as the required 

program files are copied along with the executable. Figure 5 contains a diagram illustrating the 

required directories that must be copied in order for the executable to work properly. It is 

recommended that if you are working on a project for a specific forest that you create a directory 

represented by the forest name, and work with forest data in the Data sub-directory. 
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Figure 4 – Installation Message:  Newer Version of Microsoft Active X Components Found 

 

 
Figure 5 - Required mFASST Directories and Files 
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Setting Up the Data: 

The Files Used by the mFASST Scheduler 
 

It is strongly recommended that you work with all of the required files in a Microsoft Excel 

Workbook and save them in the appropriate text format, to be described subsequently. If you 

must work with the text files directly we suggest that you use a program such as Notepad++ or 

another advanced text editor as it displays the create-linefeed, tab, and space characters used by 

mFASST. These characters are used by the mFASST scheduling program and if they are not in 

the correct format, you will get an error. The correct file formats are described below. 

 

The Basefile 
 

The Basefile (*.base) is the file that links all of the following files together in mFASST. It is the 

key that allows the program to start. The basefile links each data file with an attribute field that 

enables mFASST to function. Figure 6 shows an example of a basefile and each of the attribute 

headers that link the data together. Figure 7 shows an example of the data in an Excel spread 

sheet with attribute headers. The subsequent section “The Basefile Creator” discusses how to 

create a basefile once the following data files are created. 

 

The Shapefile 
 

The shapefile (*.shp) is the forest shapefile you would normally import into ESRI’s ArcMap. 

Each of the associated files, e.g. filename.dbf, filename.prj, filename.sbn, filename.sbx, 

filename.shp, filename.shp.xml, and filename.shx should be grouped together. The shapefile must 

contain the following Attribute Fields: SUNIT, AREA, SCHEDULE, and EFTVNS. The area, 

treatment, and effectiveness attributes are assumed to be area in acres. This file must be 

topologically correct; that is, there are no overlapping polygons or slivers within the shapefile. 

This can be achieved by converting the shapefile to a coverage and then back into a shapefile 

using ArcGIS. This can also be accomplished in other GIS packages as well.  

 

The Base Data File 
 

The Base Data file contains all information related to a treatment, be it initial or maintenance. 

The Base Data file must contain the following attribute fields: TUNIT_CL, SUNIT, P_SCHED, 

MIN_MAINT, MAX_EFFECT, SPREAD, TREAT, and PUNIT. These fields are defined in 

Table 1. Additional Base Data fields may include Earliest, Latest, and WUI for example; 

additional fields are optional and may be added by the user. For example, a Ranger district may 

want to track treatment activities in each time period that involve the Fisher or they may want to 

evenly spread out the impacts on Fisher. This can be easily added to the data fields of the 

spreadsheet and handled as an objective, a constraint, or just a data element to be charted and 

displayed. Overall, there is considerable flexibility in terms of how the user can depict their fuels 

treatment problem.  
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Each base data file must contain information on initial and maintenance treatments, however 

each type must be grouped together. When entering treatment information in the base data file, 

make sure that all Maintenance Treatments precede Initial Treatments; otherwise, the heuristic 

will not function correctly if Initial Treatments appear before Maintenance Treatments. It is also 

important to create a maintenance and initial treatment entry even if the initial/maintenance 

treatment will not be used
3
. The Base Data file should be saved as a MS-DOS text file (Microsoft 

DOS Text File), a specific type of tab-delimited text file. When saving the file it should be saved 

in the following way: *_BaseData.txt, where the * represents any chosen name. You may give 

any file name you wish to “replace” the * - for example Stanislaus_BaseData.txt. The 

program uses this naming format to distinguish base data files from other data files. 

 

 
Figure 6 - Basefile Example 

 
Figure 7 - Base Data Attribute Header Example (in Microsoft Excel) 

                                                 
3
 A row of zeros for a maintenance treatment will work if you are only trying to schedule initial treatments. If you 

are trying to schedule a maintenance treatment, it is important to specify the period in which the initial treatment 

was scheduled (assume an initial treatment was scheduled prior to the start of the planning horizon) and include a 

row of zeros for the initial treatment associated with the SUNIT. 
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Table 1 - Recommended Attributes and Values
4
 

Attribute Name Description Value to Take and Units 
TUNIT_CL Indicates whether a row entry in 

the Base Data file is an initial 

treatment or a maintenance 

treatment. 

1_New corresponds to an initial 

treatment. Initial Treatments should 

follow entered Maintenance Treatments. 

 

2_Maint corresponds to a Maintenance 

Treatment and should be specified first.  

SUNIT Spatial Unit – This is an area 

that an Initial or Maintenance 

Treatment references in the 

mFASST. 

Simple integer values; make sure that the 

Spatial Unit for a treatment corresponds 

to the SUNIT in the shapefile you want it 

associated with. 

P_SCHED This represents an SUNIT that 

was previously scheduled before 

the initial start year. 

These should be simple integer values, 

but must be specified as negative values 

relative to the start year. 

MIN_MAINT This represents the minimum 

amount of time a project needs 

before it can be considered for a 

maintenance project. 

Simple integers > 0. 

MAX_EFFECT Is the Maximum Effectiveness 

of a treatment that has been 

performed in a particular 

SUNIT. 

Simple integers > 0 

Earliest This is the earliest time an 

Initial Project can be scheduled 
Simple integers > 0 

Latest This is the latest time an Initial 

Project can be considered for 

scheduling. 

Simple integers > 0 

SPREAD The number of years an Initial 

or Maintenance Project requires 

to be completed. 

Simple integers > 0 

TREAT The number of treatable acres 

for an Initial or Maintenance 

treatment. 

Double Precision values, generally 

specified in acres. 

Budget The cost associated with an 

Initial or Maintenance 

Treatment 

Double Precision values 

WUI Wildland Urban Interface 

acreage associated with a 

treatment. 

Double Precision Values, in acres 

PUNIT Planning Unit – areas generally 

associated with Ranger 

Districts. 

Simple integers > 0 

 

                                                 
4
 Attribute names in boldface type are required; they must be spelled and represented exactly as shown here. 
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The Adjacency File 
 

The Adjacency file specifies which SUNITs are neighbors of a given SUNIT. The mFASST 

program will build the adjacency file for you; the process of creating the adjacency file is 

described in the next section under the subtitle “Selecting an Adjacency File”. If you rename the 

adjacency file, be sure to rename it in the following way: *_Adjacency.txt, where the * is the 

filename you wish to assign - for example Stanislaus_Adjacency.txt. 

 

The Budget File 
 

The Budget file is a text file that contains budget information. It can be the maximum allowable 

value to spend in a given year, the maximum number of Wildland Urban Interface (WUI) acres 

to treat in a given year, or any other value that has a maximum bound for a particular year. This 

file is also a MS-DOS formatted text file (tab-delimited). The first line specifies the number of 

years in the planning horizon. The second line specifies the attribute headers, and the subsequent 

lines specify the maximum bound values for each attribute for each year in the planning horizon. 

When naming the file, make sure you save the file as an MS-DOS text file following the naming 

convention *_Budget.txt where the * is replaced by the file name you wish to assign - for 

example Stanislaus_Budget.txt. The current version of mFASST limits the number of 

budget constraints to two. 

 

The Details File 
 

The Details File is used to specify the number of Planning Units used in a forest, and the number 

of years in the Planning Horizon. The file contains only these two lines of information and is 

formatted as an MS-DOS text file. When naming the file, make sure you save the file as an MS-

DOS text file following the naming convention *_Details.txt where the * is replaced by the file 

name you wish to assign - for example Stanislaus_Details.txt. 

 

The Permanently Fixed Out (PFO) File  
 

The Permanently Fixed Out (PFO) file lists SUNITS and the schedule code that indicates that 

this SUNIT is not available for scheduling. The file is an MS-DOS formatted text file; the first 

line contains the header attribute information. The header attributes should be SUNIT and 

Schedule_Input. The subsequent lines contain only the SUNITS not available for scheduling and 

the fixed out schedule code, a ‘-3’. When naming the file, make sure you save the file as an MS-

DOS text file following the naming convention *_PFO.txt where the * is replaced by the file 

name you wish to assign - for example Stanislaus_PFO.txt. 
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The Basefile Creator 

 

Basefile Creator adds the capability to easily and quickly create a Basefile (*.base) from scratch, 

or to load and modify a previously saved Basefile. It can be accessed in the File menu of 

mFASST. When selecting Basefile Creator on the main menu, the Basefile creator form will 

appear. It should be noted that Basefiles created in the Initial Forest Activities Spatial Scheduling 

Tool, or iFASST, will not work with the Basefile Creator used in mFASST.    

 

Creating a Basefile 
 

Before using the mFASST program, you will need to have the supporting data properly 

structured and in order. There are six required files
5
 necessary to operate mFASST: the shapefile 

(*.shp), data file ( *_BaseData.txt), adjacency file ( *_Adjacency.txt), budget file ( *_Budget.txt), 

details file ( *_Details.txt), and the permanently fixed out file ( *_PFO.txt). The location of these 

files are specified inside the Basefile (*.base) that is read into the mFASST. Although one can 

take an existing base file and edit it for a new application, it is recommended that the user use the  

Basefile Creator routine. The Basefile Creator is discussed in the section below. 

 

Selecting the Required Files  
 

There are six required file selections which were briefly mentioned above. These six files must 

be stored in their appropriate directories (see Figure 5). The Basefile Creator input form is 

designed so that the required six file selections are to be selected from drop down lists placed at 

the top left part of the form (see Figure 8).  

 

The first file field on the form (top left) is for the name of the appropriate forest area shapefile 

(See Figure 8).  The shapefile is the file that defines the forest scheduling units. The Basefile 

creator will list all shapefiles found in the following directory: 

 
           YourPathToLocationOfExecutable\Data\Data_ArcGIS\Shapefiles  

 

in the ForestName shapefile list box. Choose the shapefile of the forest you wish to use in 

mFASST from the drop down list. If the desired file does not appear on the list, make sure that 

the file is stored in the appropriate directory. It may take a few seconds for the shapefile to load 

due to its size and complexity. Note that all associated files with the selected shapefile must be 

present, e.g. filename.dbf, filename.prj, filename.sbn, filename.sbx, filename.shp, 

filename.shp.xml, and filename.shx. 

 

The second file to be selected is the name of the BaseData File; note that this is not to be 

confused with the Basefile. The BaseData file contains attribute information related to all 

                                                 
5
 Note that the * is a wildcard indicator for the name of the file you want to use, followed by the required elements 

necessary for the program to identify the file type. 
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proposed initial treatments and all proposed maintenance treatments. The BaseData file must be 

stored in the folder called “datascheduling.” Choose the desired BaseData file name from the 

dropdown list. The list box displays only those files which contain somewhere in the filename 

the exact letters: “_BaseData” and stored in that folder. The letters _BaseData can appear 

anywhere in the filename, but must appear to be recognized by the Basefile Creator. The other 

files selected on the form must also conform to this general formatting rule. This is described in 

Table 2. As several files of a given type may be stored in the same directory, it is necessary to 

use this naming convention so that the program can discern the function of the file from the 

name. Table 3 shows which directory the shapefile and other files should be saved in. 

 

 
Figure 8 - Required Files Area is highlighted (in blue) 

 

 

The third file to be selected is the Adjacency File; choose the Adjacency File that corresponds to 

the forest shapefile or select the option “Let Program Create” if the adjacency file does not 

already exist and the adjacency data file will be created by mFASST. The adjacency file contains 

the neighbors of each spatial unit in a simple text file format. If you wish to select the adjacency 

file created by mFASST, you can add the created Adjacency file by editing the Basefile once it is 

created; reading in a previously created Basefile will be discussed in a subsequent section. The 

directory the adjacency file will be created in can be found in Table 3.   
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Table 2 – File Name Flags 

Each of these files should contain the following text within the file name:  

File Required Text 
BaseData File  _BaseData 

Adjacency File _Adjacency 

Budget File _Budget 

Details File _Details 

Permanently Fixed Out _PFO 

(e.g. Stan_BaseData.txt or Stan_3000_BaseDataNew.txt) 

 

Table 3 – Directories Data Should Be Stored In 

File Directory to Be Saved In 
Shapefiles (Directory of Executable)\Data\Data_ArcGIS\Shapefiles\ 

Basefiles (Directory of Executable)\Data\BaseFiles\ 

Other Data Files (Directory of Executable)\Data\Data_Scheduling\ 

 

 

The fourth file to be selected is the name of the Budget File; choose the budget file that 

corresponds to the desired forest area. The Budget File contains information related to the 

available budget for a given year as well as any other attribute that has an associated budget, e.g. 

Wildland Urban Interface acreage that can be treated in a given year. Note the field names that 

are used in this file must correspond to field names given in the BaseData file. If the column 

fields do not match, the program will indicate that there is an error in the column headings of this 

file. Make sure that the naming convention found in Table 2 and the directory in which the file is 

saved match the “Other Data Files” row of Table 3. 

 

The fifth file name to be selected is the Details File; the Details File specifies the number of 

Planning Units (i.e. Ranger Districts) and the planning horizon to be used in years. Make sure 

that the number of Planning Units matches the number of Planning Units found in the shapefile 

of the forest. This file should correspond to the desired forest area and contain the file name 

conventions given Table 2 and be saved following the “Other Data Files” row found in Table 3.  

 

The sixth file is the Permanently Fixed Out file, or PFO file for short. This file indicates what 

Spatial Units, or S-Units, are not available for scheduling and should therefore not be considered 

candidates for scheduling. The Spatial Units fixed out should not be included in the BaseData 

file. 

 

Shapefile Field Selector 
 

The Shapefile Field Selector becomes active after a shapefile has been selected in the Required 

Files area. The fields listed in the Shapefile Field Selector are not the same as the BaseData File 

(Data file); the Shapefile Field Selector fields are read in directly from the shapefile attribute 

table. Three shapefile attribute fields are required in order for the basefile to function correctly. 

The required fields are the SUNIT, AREA, and EFTVNS fields. Table 4 contains the name that 
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should be in the Attribute Table, the alias of the name, and the attribute’s definition. To select 

other fields that you wish to include in the basefile, select the checkbox next to its name.  

 

Table 4 – Required Shapefile Attributes 

Attribute Name Attribute Alias Definition of Attribute 
SUNIT Spatial Unit This is the number that delineates an initial or 

maintenance treatment area. 

AREA Area of Spatial Unit This is the total area of a Spatial Unit 

SCHEDULE Schedule This field is used by the heuristic for scheduling 

only; do not enter values into this attribute. 

EFTVNS Effectiveness This is the total number of effective acres that are 

associated with a given spatial unit. This is 

equivalent for initial and maintenance treatments. 

 

If you wish to have an attribute from the shapefile appear in the Left Hand Side (LHS) display of 

mFASST, or on the Chart form, select the appropriate checkbox associated with that attribute. If 

you are unsure of the shapefile field associated with the corresponding checkbox, highlight that 

entry and hover over the list with the mouse. A Tool-Tip-Text should pop-up and identify the 

corresponding shapefile field. An alias can be given to the shapefile field by double-clicking the 

corresponding Display Heading list entry. Again, if you are unsure of the shapefile field 

association, highlight the entry and hover over the list with the mouse and a Tool-Tip-Text will 

pop up (See Figure 9). Once you have selected all of the attributes and how you want that 

information to be displayed in the Shapefile Field Selector, you may choose which BaseData File 

you want to use. 

 

 
Figure 9 – Tool-Tip-Text and Highlighting 
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BaseData File and Associated Fields  
 

The BaseData File Name combo box should be available for use once you select a shapefile 

name from the combo box above it. It is important that you keep track of the BaseData file that 

you want to use, as it MUST relate to the shapefile through the specified attribute: S-Unit or 

Spatial Unit and also must correspond to the forest that you want to use. Figure 10 shows the 

two areas that become active once a BaseData File has been chosen. The first field is the Data 

File Field Name Settings, and the second field is for the Constraints.  

 

 
Figure 10 - BaseData File and Associated Fields 

 

 

The Data File Field Name Settings become active once a BaseData file has been selected. The 

process of Selecting, choosing an alias, as well as the Chart and Left Hand Side (LHS) display 

options follow the same procedure as the Shapefile Field Selector. The “SUNIT” field should 

always be present in the DataFile and be selected. ToolTipText will again aid in determining 

which attribute field row you are working in by highlighting the text of the option in question. 

 

The Constraints section contains three constraint fields; two of which will become available after 

you have chosen a BaseData file. The first is the Earliest Time constraint, the second is the 

Minimum Acreage Constraint. The Earliest Time constraint in this case only applies to “Initial 
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Treatments”; the earliest time a “Maintenance” project can be scheduled is computed by adding 

the P_SCHED attribute value and the MIN_MAINT attribute value together. The Earliest Time 

constraint is the only optional constraint; you can choose the field that represents the earliest 

time constraint by activating the constraint (checking the checkbox) and then choosing a field 

from the drop-down combo box. The field that you choose should represent the time period in 

which the earliest scheduling can take place.  

 

The Minimum Acreage constraint is a required constraint; if you leave the text “Min Acreage?” 

unchanged, the minimum acreage will default to 25 acres and use the “TREAT” attribute field as 

the default field. Decimal entries will be concatenated to the integer value that precedes the 

decimal (e.g. 20.212 = 20, 20.945 = 20, 21.212 = 21, 21.945 = 21, etc.). If you wish to use a 

different minimum acreage value, you will need to set it in and choose the field that represents 

the minimum acreage attribute. If you wish to use the default minimum acreage value and a 

different minimum acreage attribute field, you must specify the acreage value you wish to use in 

the minimum acreage field and choose the attribute field you wish to use. The minimum acreage 

value will not set itself by default. Once you have selected and set in the settings you wish to use, 

you may set the Adjacency File. 

 

Adjacency File Selection 
 

You will need to let the mFASST create the adjacency file you want to use when using a forest 

for the first time. To do that, simply choose the option “Let Program Create”. If the forest 

already has an adjacency file associated with it, you may choose it from the dropdown list. If you 

need to rename an adjacency file, make sure you use the *_Adjacency.txt where the * represents 

the filename you wish to use saving it in the correct directory and then restart Basefile Creator. 

 

Budget File Selection 
 

Once you have chosen a Budget File from the drop down box, you must select at least one 

Budget Constraint. The Budget Constraint related to the file will appear in Constraints Section; 

you should see some attribute names appear in the Budget Constraints Selected section. Only 

values that appear in the Budget file as well as the BaseData file will appear as possibilities. 

Double clicking on an entry will allow you to give the attribute an alias. Highlighting an entry 

and then right clicking on it will provide you with the attribute name, alias, and the data provided 

in the Budget File. See Figure 11 for an example display of data given in the associated budget 

file (after highlighting and right clicking). If you need to rename the Budget File, make sure you 

use the *_Budget.txt where the * represents the filename you wish to use. 
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Figure 11 - Budget File constraints and Budget Attribute Information 

 

Details File Selection 
 

Choose the appropriate Details File that you wish to use in mFASST. The Details File contains 

information regarding the number of years in the planning horizon as well as the number of 

Planning Units to use when scheduling. If you need to rename the Details file, make sure you use 

the *_Details.txt where the * represents the filename you wish to use. 

 

Permanently Fixed Out (PFO) File Selection  
 

The Permanently Fixed Out (PFO) file is the last file to be selected. Simply choose the PFO file 

that you wish to use. Make sure that it relates to the forest that you wish to use. If you do not 

wish to permanently fix out any spatial units, then specify a PFO file without any treatments 

entered into it. 

 

Opening the Objectives Form 
 

Before opening the Objectives Form of the Basefile Creator, make sure that the files you want to 

use are the correct files. Once you have verified the files and attribute settings you wish to use, 
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click on the Open Objectives Form Button. Figure 12 shows the objectives form window. A 

maximum of five objectives may be set; you could have five Evenflow objectives or five Total 

Value Objectives for example. To turn on an objective, simply select the checkbox next to that 

objective type and its name. At the top of the form, you should see a bold value that says, 

“Objectives: ( x ) / 5” where x is the total number of objectives currently selected. 

 

 
Figure 12 - Basefile Creator Total Objectives Form 

The Adjacency Objective  

 

The Adjacency Objective is used to try and schedule projects that are neighbors in the same, 

prior, or subsequent year as a neighboring project. You must choose which sense to use; the 

maximize or minimize sense. Maximizing adjacency will try to schedule as many neighboring 

projects as possible, essentially building a cluster of scheduled projects. Minimizing adjacency 

will attempt to distribute scheduled projects such that there are minimal neighboring projects 

scheduled. 

 
The Spatial Distribution Objective  

 

The Spatial Distribution Objective is different from the Adjacency Objective in that the Spatial 

Distribution Objective is designed to attempt to schedule treatments in regions, like ranger 

districts. For example, if a forest has four ranger districts and you want to schedule at least one 

project in each ranger district in each year, you would select the Spatial Distribution Objective 

and use the PUNIT, or Planning Unit. 
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The Evenflow Objective  

 

The Evenflow Objective attempts to keep the variation of an attribute the same from year to year. 

For example, if you select treated acreage as your attribute it will try to keep the amount of 

treated acreage the same from year to year. Checking the Evenflow checkbox will activate the 

Evenflow Objective Fields (“Fields to Use”) and “Field Label” lists. To choose a field to 

Evenflow, simply select the checkbox next to the attribute name in the “Field to Use” list; the 

corresponding “Field Label” checkbox should also automatically check itself. To give the field 

an alias, simply double click the corresponding text in the “Field Label” list and type in the alias 

you wish to use. 

 
The Total Value Objective  

 

The Total Value Objective maximizes or minimizes the total value of a particular attribute. For 

example, if you chose maximize the attribute TREAT (Treatable Acres), then the total sum over 

all years of treatable acres would be maximized and included as an objective. If you chose to 

minimize the attribute HABCRIT, or Critical Habitat, then the total sum over all years of critical 

habitat acreage scheduled would be minimized and included as an objective. To use the Total 

Value Objective, select the check box by the objective name and then simply select the checkbox 

next to the attribute name for which you wish to apply the objective in the “Field to Use” list; the 

corresponding “Field Label” checkbox should also automatically check itself. To give the field 

an alias, simply double click the corresponding text in the “Field Label” list and type in the alias 

you wish to use. To set the maximization or minimization sense, select the corresponding entry 

in the “Max/Min” list; the maximization sense is the default sense. Checking the entry will set it 

to the minimization sense. 

 
The Discount Objective  

 

The Discount Objective discounts an attribute an attribute over time. This objective can be 

defined in one of two ways: maximization or minimization. The difference is that when 

maximizing, it will tend to schedule projects as early as possible in the time horizon, and when 

minimizing it will attempt to schedule projects as late as possible in the time horizon. It does this 

by using a discount function. For example, when maximizing, it gives a high value for scheduling 

an treatment in a SUNIT with the desired attribute in the initial period, a slightly lower value for 

scheduling that treatment in the second period, and continuing until the value for scheduling 

reaches zero in the last time period. For minimization, the value for scheduling in the first period 

starts at zero and rises in each subsequent time period until it reaches the highest scheduling 

value in the last time period. For example, if you choose the attribute WUI (short for Wildland 

Urban Interface lands), and chose the maximization sense, the projects would be scheduled 

earlier rather than later if at all possible. If the minimization sense is chosen, then 

projects/treatments containing WUI lands would be put off as long as possible. To use the 

Discount Objective, select the checkbox by the objective name and then simply select the 

checkbox next to the attribute name for which you wish to apply the objective in the “Field to 

Use” list; the corresponding “Field Label” checkbox should also automatically check itself. To 

give the field an alias, simply double click the corresponding text in the “Field Label” list and 

type in the alias you wish to use. To set the maximization or minimization sense, select the 
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corresponding entry in the “Max/Min” list; the maximization sense is the default sense. Checking 

the entry will set it to the minimization sense. 

 

Setting the Objectives and Saving the Basefile  
 

Once you are done setting all desired objectives (up to five), click the “Set Objectives” button. 

Make sure you’ve chosen all of the values you wish to have as objectives. Exiting the form by 

clicking “Exit” will close the objectives form. If you need to re-open the objectives form, you will 

lose your previous objectives settings (if set) and will have to start over from scratch. After you 

have set your objectives using the Basefile Creator Total Objectives form, you should click the 

Save Basefile button on the Basefile Creator form, or on the menu bar, click File -> Save 

Basefile. Once you have assigned a name to your basefile and saved it, you may exit the 

Basefile Creator by closing the form using the “X” button at the top right corner of the form, 

clicking the “Exit Basefile Creator” button, or using the menu bar by clicking File -> Exit 

Basefile Creator. 

 

Opening a Previously Saved Basefile in the Basefile Creator 
 

Opening a previously saved Basefile is a convenient way to create variations of a previously 

generated Basefile. To open a previously saved Basefile, simply do the following:  

go to File -> Open Previously Saved Basefile. All of the settings should be set 

into the Basefile Creator and Basefile Creator Total Objectives form as they were in the saved 

basefile and a message should pop up informing you that the basefile opened successfully. It is 

important to note that the Basefile Creator Total Objectives form window, if closed, will not 

automatically repopulate itself. When editing the objectives and constraints, you should follow 

the procedure outlined in the previous section that describes how to make a basefile from scratch. 

You should make changes to the objectives by first setting them in the Basefile Creator Total 

Objectives form, set them, and then set the constraints in the Basefile Creator form itself. 

 

If the Basefile was developed without the use of Basefile creator, and that file contains errors, 

Basefile Creator will load everything that has been formatted correctly up to the point that an 

error has been detected in a given section. Thus, if a constraint has been specified incorrectly, it 

will skip the rest of the file including constraints, objectives, and minimum area specification.   

 

Using the Maintenance Forest Activities 
Spatial Scheduling Tool 

 

The Maintenance Forest Activities Spatial Scheduling Tool (mFASST) enables a user to quickly 

generate a solution to a scheduling problem. The problem can be composed of up to five user-

specified objectives and several user-specified constraints. Information on how to specify the 

objectives to be used and what each objective involves is found in the previous section. The 

following describes how to run the tool. 
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Opening a Basefile in the Maintenance Forest Activities Spatial 
Scheduling Tool 
 

To use the Maintenance Forest Activities Spatial Scheduling Tool (mFASST), you will need to 

open a basefile, a file that contains all of the references to the required data files necessary for 

successful operation of the scheduler. Opening a Basefile in mFASST can be done two ways. 

The first way is to use the File Menu: File -> Open. The second way is to use the open 

basefile button in mFASST (See Figure 13). This will open a common dialogue box that will 

enable you to navigate to and open an existing Basefile. 

 

 
Figure 13 - Opening a Basefile in mFASST 

 

Running the Activities Scheduling Heuristic 
 

Running the activities scheduling heuristic in mFASST is done by first opening the Heuristic 

Window. This can be accomplished in two ways. The first is to use the menu bar by first 

selecting view and then navigating and selecting the heuristic: View -> Heuristic. The second is 

to click the Heuristic button on the toolbar (See Figure 14) which is the button with the icon of 

red and blue polygons. Upon selecting the activities scheduling heuristic, the heuristic options 
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window will appear. This window contains three sections of information/options. The left most 

section lists each of the objectives specified in the basefile that is currently opened. Each of these 

objectives can be weighted differently; the default weight is set to one. One can click on any one 

of the objective weight dialog boxes and enter a different weight.  The Finney Objective Weight 

is not entered or viewed in the heuristic options window; to set this weight value you must click 

the “Set Finney Objective Weight” button located in the top right of the mFASST window and 

enter in the number you wish to use as the objective weight. All objective weights should be 

greater than or equal to zero. The second or middle section deals with a flex grid that allows the 

option of fixing in or out a specific treatment at a specific time period. The third or rightmost 

section in the heuristic options window displays constraint values for up to two different 

constraint types, of which one is usually a yearly budget.  Updating the constraint values and 

fixing specific SUNITS into the schedule at a specific time period is described in the next section. 

 

 
Figure 14 - Opening the Heuristic Window 

 

To start the scheduling heuristic, click on the Start button of the scheduling heuristic options 

window. This will trigger several actions:  

 

1) The scheduling options window will be closed and the user will be prompted for a file 

name under which the schedule will be stored. This schedule will be in a text file format 
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and stored in the Schedules folder described in Figure 15. It is important to select a 

name which is indicative of which options are used in the problem being solved. Using 

unique names allows a user to store several schedules associated with a given base file 

and retrieve them at a later time for review and comparison. This text file is described at 

greater length at the end of this manual. 

 

2) The heuristic will begin solving the selected problem. When it has completed solving the 

problem, it will display the solution in the map window using the default color scheme if 

one has not already selected a color scheme. Most users will first run the heuristic and the 

let the solution be displayed using the default colors. Then after that solution is displayed, 

the user can then select a color scheme or create a unique one for their use.  

 

 
Figure 15 - Save Heuristic Schedule Solution File Name and Default Directory 
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Fixing projects into the schedule and Updating constraint values  
 

If you wish to fix a maintenance or initial treatment into the solution, specify it in the “Fix 

Project” section of the scheduling heuristic options window. Treatments are listed numerically 

from 1 to n, the number of listed treatments in the scheduling data. If you wish to know which 

treatment number corresponds to a specific Spatial Unit (SUNIT), simply save the “Fix Project” 

file as a text file and then open it with Notepad to observe the correspondence between the 

treatment numbers and the spatial units. Figure 16 shows the dialogue box and location to save 

“Fix Project” information to read into the program at a later time. To eliminate a treatment as a 

potential scheduling candidate, enter in a “-1”. To leave the treatment open for the heuristic to 

schedule, enter in a “0”. To specify a specific year, enter in the year. If there are no preset 

conditions in the Fix Project options section, then the scheduler will attempt to find the best 

solution possible given this flexibility.  

 

 
Figure 16 - How to Save Fixed Projects Information 

 

 

If a user decides to fix into the schedule a number of projects and desired schedule times, it is 

possible that they may specify a course of action which violates one or both budget limits in a 
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given year. The scheduling heuristic will detect this possibility on an initial analysis of the data 

and exit with a message that no feasible solution exists to the data and conditions as specified. 

The scheduler will not in any circumstance allow a user to violate a constraint in building a 

solution. It is possible, however, to consider such a case only by changing the constraint values 

in the third rightmost section of the options window.  It is important to understand that setting in 

pre-scheduled events will not be automatically saved for future reference. This must be done by 

clicking the file save button next to the label “Fix Project.”  

If you wish to use this specific set of values at a later time, you need to reset the values by 

clicking the “folder” button in this section of the form.   

 

To change a budget constraint value for a given year, simply change the value for the constraint 

you wish to restrict in the “Constraints” list (third and rightmost section of the heuristic options 

window). Once you are satisfied with the values you have entered into the “Heuristic” options 

window, then click the “Start” button, and begin the solution process. Note, any edits on the form 

for constraints will not be saved. To create a permanent set of changes to the budget constraints, 

it is necessary to create a new budget file. 

 

Interpreting the Results of a Heuristic Run 
 

When the heuristic finishes running a message box will notify you that it has finished running. 

You should then see the name of the schedule you saved the run as appear in the “Schedule” 

combo box; the “Color” combo box will also now be enabled allowing you to choose a color 

scheme to display the loaded schedule. The section “How to use the Legend” below describes 

how to change the legend coloring scheme in more detail. If you navigate to the directory in 

which the schedule is saved, Executable Path\Data\Schedules\ you will see a text 

file with the name of the schedule you saved. If you open the text file, you will see the schedules 

for maintenance treatments, and initial treatments. Following these, there is a table that provides 

a breakdown of the area and number of units meeting the Finney Criteria by scheduling period 

(year generally). The next section provides a visual breakdown of when a unit meets the Finney 

Criteria; a one (1) means that the Finney Criteria is met, a zero (0) means that the Finney 

Criteria is not met. Following this, there is some information that is used by the chart feature, 

followed by a “Work Report” section that provides a breakdown of treatments and their 

associated SUNITS that are scheduled in a given year. The following section describes how to 

use the included map and Graphical User Interface (GUI) to interpret data from the program 

itself. 

 

Displaying the Heuristic Results 
(Schedule) 

 

A schedule generated by mFASST can be displayed by clicking an entry in the Schedule Combo 

Box at the bottom left of the mFASST window. A generic legend color scheme can be displayed 
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quickly by clicking an entry on the Color combo box directly beneath the Schedule combo box 

(See Figure 17). 

 

 
Figure 17 - Where to Select the Schedule and Color of the Legend 

 

How to use the Legend 
 

You can choose to create your own color scheme by left clicking on any of the colors depicting a 

year a project was scheduled. This will bring up a dialog box that will enable you to choose a 

particular color you wish to use for that year.  

 

 
Saving and Opening a Legend Color Scheme 
 

If you have made changes to the legend and wish to save the legend color scheme, simply 

navigate to the menu bar and left click the “Save Legend Color Scheme” option. To open a 

previously saved color scheme, simply navigate to the menu bar and left click “Open Legend 

Color Scheme”. Figure 18 shows the menu where you can save a legend color scheme as well as 

open a previously saved legend color scheme. 
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Figure 18 - Saving/Opening a Custom Color Scheme 

Operations Using the Legend, Mouse Buttons, and Shift/Control Keys 
 
Left Click 

The legend can also be used to display important information such as: projects scheduled in the 

same year, projects scheduled up to and including that year, and projects that are in the process 

of being treated for a given year. If you Left Click on the number representing a particular year in 

the scheduling legend, the year that is selected (by the left clicked) will turn red, as well as the 

mapped SUNITS scheduled during that year (See Figure 19 for an example involving year 5 of 

the schedule). Left clicking on another year will change the year in which the units are 

highlighted in red to the selected year. To clear this feature from the map display, simply left 

click on the -999 number at the bottom of the legend.  
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Figure 19 - Legend Left Click 

 
Right Click 

If you Right Click on a year in the scheduling legend, project treatments within an SUNIT that 

have been scheduled from the first time period up to the point in time that has been selected will 

be displayed on the map in orange; SUNITS that have not been scheduled will be displayed in 

white (See Figure 20). To clear the display of scheduled projects that have been scheduled 

through the year clicked on, simply left click on the -999 entry. 
 
Shift+Left  Click  

If you hold the Shift Key down and Left Click on a year, the map will show which units are 

currently scheduled; the year for which the Shift Key & Left Click will have a blue bounding box 

shown around the legend year, and on the map maintenance treatments will be shown in gold-

yellow and initial treatments will be shown in purple (See Figure 21).  
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Figure 20 - Legend Right Click 

 
Figure 21 - Legend Shift Key & Left Click 
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Showing Specific Treatment Types on the Map and Legend  
 

There are three types of maps that can be shown in mFASST: “Show All,” “Show Initial,” and 

“Show Maintenance.” Each of these map types and what they display is explained in following 

sections (See Figure 22). 

 

Map Option “Show All”  
 

When using mFASST the default map view is set to “Show All”. This view shows the year in 

which a treatment has been first scheduled. For example, say an initial treatment in SUNIT ‘X’ is 

scheduled for year 1 and a maintenance treatment is scheduled in year 16, the “Show All” option 

would list the SUNIT ‘X’ as being treated in year 1. When using this option, the chart will also 

display data for all scheduled projects by the year in which the first activity is scheduled. The 

following section describes how to use the chart in greater detail. All operations related to the 

use of the legend, as previously described, work in each view type. Figure 22 shows how to 

choose the map display type.  

 

 
Figure 22 - Mapping Options 
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Map Option “Show Initial”  
 

When using the “Show Initial” feature in mFASST, the program will display only scheduled 

initial treatments and chart data that is pertinent to initial treatments. The operations previously 

described relating to the legend will function the same in this view.  

 

 
Map Option “Show Maintenance”  
 

When using the “Show Maintenance” feature in mFASST, the program will display only 

scheduled maintenance treatments and chart data that is pertinent to maintenance treatments. The 

operations previously described relating to the legend will function the same in this view. 

 

 
Figure 23 - How to Open the Chart 

Using the Chart 
 

The chart will show information dependent upon what type of “Map” is currently being 

displayed (“All”, Initial, or Maintenance), and will only be displayed after a schedule that is 

associated with an opened basefile has been loaded. The chart window will be added to the 
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display if you click on the chart icon or by navigating to the main menu View->Chart. Figure 

23 shows the “view” menu to navigate in selecting the “chart” option as well as a picture of the 

icon that can be selected on the tool bar.  

 

The chart window has a two main ways to display data; the first is a checkbox at the top left of 

the chart window that enables the user to see both projects that have been scheduled and 

unscheduled. An unscheduled project is either a user fixed out project (-1), a project that was not 

able to be scheduled within the specified resources and constraints (-2), or a project that was not 

able to be scheduled because it didn’t meet the minimum scheduling criteria (-999) – usually 

based upon a minimum treatable acreage constraint. When the box is left unchecked, the chart 

displays activities across the time horizon, with the scale of the y-axis based upon the largest 

amount of scheduled activity in any time period over the planning horizon. When the box is 

checked, both scheduled and unscheduled amounts are displayed, where the scale of the y-axis is 

based upon the largest amount scheduled in any time period or the largest amount in the category 

types of unscheduled amounts (-2, -1, and -999) (whichever  is the largest).  

 

The second chart option involves selecting the type of data to be viewed; this is the combo-box 

located in the top right of the chart window. The options that will appear in the combo box will 

vary – some entries are set when the user creates the basefile (i.e. data display list). However, the 

Finney chart entries and the number of projects scheduled entry will always be present as a 

display option in the chart. Figure 24 shows the locations of the checkbox and combo box used 

to display these types of data. 

 

The chart displays for a given selection, e.g. WUI acres, the distribution of activities over the 

planning horizon. Although the map helps to give a picture of how the activities are scheduled 

over space and time, the map does not display the magnitude of the activities in terms of acres 

treated in any given year, the number of projects started in a given year, or the accomplishment 

of specific goals, like treating WUI in the early years of a planning horizon. An example of the 

chart display is given in Figure 25. In Figure 25, the chart displays the distribution of WUI 

acreage over the planning horizon. In this case, an objective that prioritizes scheduling WUI 

acreage early on has been chosen. By hovering the mouse over any bar representing a year, a 

pop-up information box will display the year and amount associated with the schedule in that 

year. For example, the amount of WUI acreage scheduled in year two is displayed as a pop-up 

information box in Figure 25. 
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Figure 24 - Charting Elements 

 

 
Figure 25 - Example of Charting WUI Acreage 
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The chart display can be used in conjunction with the map display. By left or right clicking with 

the mouse on a given bar on the chart, the SUNITs on the map that represent this bar (activity 

type and time period) are displayed in red on the map. Thus, one can easily review both the totals 

of a given activity in a time period, but see where these activities take place on the map. Figure 

26 illustrates this feature, showing the years scheduled on the map.  

 

The chart can be used to understand the various elements of the schedule in terms of the 

magnitude of operations in each time period. By using both the map and the chart display, one 

can understand the ramifications of a given schedule. If there is something that is desired by the 

analyst, it is possible, e.g. schedule a specific unit earlier that what was generated by the 

scheduler, for one to schedule that unit manually (see section on fixing projects into the 

schedule), and then resolve the scheduling problem. When one takes this action, it is best to save 

this information and create a new scheduling scenario, in order to keep both the original schedule 

and the new schedule as files, so they can be retrieved at a later date. Anytime a schedule is 

generated, the user is prompted to enter a name for the schedule file associated with that 

particular run of the heuristic. By entering a unique and informative name for the schedule, one 

can retrieve that schedule at a later time and understand under what conditions that schedule was 

generated.   

 
Figure 26 - Chart Selection & Selection on Map 

 

Printable schedule and summary of activities  
 

Each time a schedule is generated by the heuristic, a special text file is written and stored in the 

Schedules Folder (see Figure 5). By using windows explorer, one can navigate to this folder and 

view individual schedules. Each time the heuristic is run, the user is prompted to give a name to 

this schedule (see Figure 15). This named schedule file can be viewed by notepad or some other 
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text editor. This file is quite important for the operations of the scheduler as it is used to reset the 

program and display to a specific schedule that is selected (see section on Displaying the 

Heuristic Results). For the program to retrieve a given schedule, it reads this file and uses the 

information at the front end of the file to reset the scheduling arrays and chart arrays, so that it 

can display the schedule on the map and on the chart windows. This file is also useful to the 

analyst, as it contains specific scheduling details for each SUNIT and a five year program of 

work report. The schedule file contains the following sections:  

 

 Problem information: objective importance weights, the composite objective value, etc.  

 SUNIT schedules: lists that activities that are scheduled for each SUNIT and when 

Finney Totals: lists the total acreage that meets the Finney condition by time period 

Distribution: for each SUNIT it indicates with a”1” the years in which it meets Finney 

Chart totals: gives the total of a given type of activity for each time period 

Program of Work Statement: presented for the first five years of the schedule 

 

This schedule file can then be edited and merged into GIS files and edited and read into 

Microsoft Project for operations tracking. Specific sections can also be easily edited and printed 

for use in reports and planning documents. If a file is edited, make sure to do that on a copy that 

is made and placed outside of the Schedules folder, as a corrupted schedule file cannot be read 

by the mFASST program. Examples of specific sections of the schedule file are presented in 

Figure 27, Figure 28, and Figure 29. Figure 27 shows the header information contained in the 

schedule file, as well as information pertaining to each treatment and its associated SUNIT. 

Figure 28 shows the Finney Elements and an index of when each SUNIT is within the Finney 

threshold. Figure 29 contains detailed scheduling information for the first five years of the 

planning horizon, as well as other scheduling information. 
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Figure 27 - Heuristic Solution File Header and Schedule Information 
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Figure 28 - Heuristic Solution File Report on Finney Elements 
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Figure 29 - Heuristic Solution File Report: Progress of Work Report 
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History of development 

 

The program described in this document has morphed through three different phases. The first 

phase involved the development of a prototype stand-alone scheduler originally coded by Jesse 

O’Hanley. This stand-alone scheduler was integrated into a map-user interface that was designed 

and coded by Richard Middleton. This original code had a number of fixed components and was 

designed to solve a specific scheduling problem involving only initial treatments. This was called 

iFASST. The first version of iFASST was a proof of concept model. 

 

As the iFASST program began to be used by the fire planning team, called the fire cadre, a 

number of refinements were suggested. This led to the next version of iFASST. This next version 

represented a substantial rewrite and restructure of the scheduling heuristic by Richard Church 

and a number of enhancements of the interface by Lisa Murawski. Although the basic layout of 

this version of iFASST was quite similar to that originally laid out by Richard Middleton, Lisa 

Murawski added considerable flexibility in display functions and data design. The final version 

of iFASST included a new function called the basefile creator. This function reduced the errors 

that were commonly made in setting up basefiles by hand. This added functionality was 

programmed by Matt Niblett. Matt also enhanced functionality by enabling a user to save and 

open user-defined color schemes, in addition to fixing a number of bugs and keeping the 

program consistent with the latest versions of ESRI’s ARC/map.  

 

The latest version of this project resulted in the development of an enhanced scheduler called 

mFASST. This was first programmed to be compatible with ESRI’s ARC/map 9.2 objects. When 

ESRI released version 10.0, they changed support for Map Objects, requiring several 

components to be licensed through Arc/server rather than a workstation license. This 

requirement triggered a reassessment of whether Map Objects should be continued in its use for 

mFASST. In January 2011, alternatives to Map Objects were evaluated and the decision was 

made to consider the use of MapWindow GIS active X controls, instead of ESRI’s map objects. 

Based upon this decision, a small prototype was programmed to test needed mapping 

functionality based upon MapWindow controls. This test was successful and from this point, 
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Matt Niblett reprogrammed the mFASST mapping routines based upon MapWindow GIS 

instead of ESRI’s ARC/map. This development was quite substantial and has resulted in the 

current release of version 2.0 of mFASST. This manual is based upon that new release. Although 

it is based on spatial information using ESRI’s shape file format, there are no license 

requirements to use this file format. Thus, mFASST 2.0 does not require any license or purchase 

of any software to run in a MS Windows environment. It has been tested in Windows XP, Vista 

and Windows 7 environments and no compatibility issues have been identified to date. The 

executable of mFASST 2.0 is now publically available.  
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